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Abstract 

Percutaneous cholangioscopy is a minimally invasive interventional 

radiology (IR) procedure that can be an alternative treatment for patients with 

complex gallstones who are not candidates for traditional surgical intervention. 

Interventional radiologists anecdotally find that few patients and referring 

physicians are familiar with this procedure, precluding some patients from this 

treatment option.  

With the paucity of accessible educational materials on this topic, we 

created a patient education pamphlet and video animation to explain 

percutaneous cholangioscopy to both patients and referring physicians. We ran a 

pilot study to compare a text-only explanation of the procedure against a text and 

images explanation. Learning was assessed through pre/post-testing and 

engagement was measured using Likert-scale surveys. We recruited family and 

friends (non-physician group) to represent our intended patient population and 

received 19 total responses. We also recruited 20 IR residents (physician group) 

as our representative referring physician population and received 12 responses.  

To analyze our data, we performed f-tests and t-tests to check for 

differences in pre/post test scores and engagement survey scores. The pilot 

survey showed that both text-only explanations and text with images 

explanations improved test scores in the non-physician group, and there was no 

significant difference in their final scores. The physician group scored high 

regardless of intervention. In both the physician and non-physician groups, a 

majority of participants preferred the explanation of percutaneous 
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cholangioscopy that included visuals aids. The most common feedback we 

received pertained to the value of learning from our visuals or requesting visuals 

be added if they did not receive any. 

Our pilot test suggests the importance of including visuals in the 

explanation of new procedures such as percutaneous cholangioscopy. Next, we 

will investigate this further through an IRB-approved study planned to test larger 

samples of patients of the procedure and possible referring physicians. Our study 

could inform best practices for developing patient education materials in 

interventional radiology. Additionally, the multimedia we create will be made 

available online to help raise awareness of percutaneous cholangioscopy and 

help improve understanding of the procedure in both patients and physicians.    

Jennifer A. Wang 
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Introduction 

What is interventional radiology and percutaneous cholangioscopy? 

Percutaneous cholangioscopy is a minimally invasive interventional 

radiology procedure that can effectively treat patients in an outpatient setting 

while reducing risks, lowering costs, decreasing length of stays, and improving 

recovery time (Ahmed et al., 2015). Percutaneous cholangioscopy has been 

proposed as an alternative treatment for patients with complicated bile stones 

who are not candidates for traditional surgical interventions (Sato et al., 1998; 

Lee et al., 2002; Bonnel et al., 1991; Brambs et al., 1996). In this procedure, 

interventional radiologists use a combination of fluoroscopy and endoscope 

visualization to access the biliary system through a small incision in the right 

upper quadrant of the abdomen, where the gallbladder is located (Figure 1). A 

scope is inserted through a peel-away access sheath, and once the stones are 

located, a basket is inserted to evacuate the stones through the peel-away 

sheath pathway (Ahmed et al., 2015). Cholangioscopy is combined with laser 

lithotripsy to break down the stones that are too large to fit in the basket into 

smaller fragments, which can then also be removed through the tube pathway 

(Ahmed et al., 2015). Percutaneous cholangioscopy has been reported in 

multiple studies to be effective in treating and removing gallstones in 80-93.9% of 

cases (Lee, 2001; Bang, 2020).  
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Figure 1. Examples of techniques used in the percutaneous cholangioscopy 
procedure. Figure from Ahmed et al., 2015. (A) Cholangiogram with white arrow 
pointing to filling defect; (B,C) Gallstone visualized with endoscope and laser 
directed at stone in preparation for laser lithotripsy; (D) Post-procedure 
cholangiogram demonstrating cleared gallstones and restored bile flow through 
biliary system. 
 

In addition to therapeutic applications, a broader application of 

percutaneous cholangioscopy includes diagnosing biliary strictures and 

biliary/hepatocellular carcinomas through distal biopsies. Percutaneous 

cholangioscopy guided biopsies have demonstrated an 80-89% accuracy in 

diagnosing biliary malignancies (Kim et al., 2008). The diagnostic applications of 
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percutaneous cholangioscopy are an indication of how this procedure can be a 

useful option in accurately diagnosing pre-operative malignancies when other 

tests remain inconclusive. These studies reveal how percutaneous 

cholangioscopy can be an effective treatment both for therapeutic and diagnostic 

solutions, however, the interventional radiology team at Hopkins believes it is still 

under-utilized for eligible patients.  

Patient informed consent and effective physician referrals 

Interventional radiologists anecdotally find that few patients and referring 

physicians are familiar with this procedure or other benefits of interventional 

radiology, which can burden the informed consent process and preclude some 

patients from the treatment option. Patients can often be overloaded during the 

informed consent process (Ripley et al., 2015), feel that they do not receive 

enough information prior to procedures (Akkad et al., 2004) and may not 

completely understand the procedure to which they are consenting (Rothberg et 

al., 2010). In a study looking at informed consent for percutaneous coronary 

interventions, patients had a contrasting understanding of the benefits of this 

intervention compared with their cardiologists, despite spending time hearing 

about the procedure in their appointment (Rothberg et al., 2010).  

Practices obtaining informed consent are often variable (Schenker & 

Meisel, 2011), and as a result, informed consent for IR procedures, and 

percutaneous cholangioscopy specifically, is often an incomplete process. 

However, multiple studies have demonstrated that patients with an increased 

knowledge of their treatment resulted in decreased decisional conflicts, a better 
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understanding of and better compliance with their treatment plan, and an overall 

increase in patient satisfaction (Lopez-Olivo et al., 2019; Bertakis, 1977). 

Determining an effective method to increase a patient’s understanding of their 

medical care is crucial to improve patient satisfaction and ideally result in better 

overall health outcomes. 

Role of Visual/Multimedia Learning in Patient Education 

Visual aids have proven to be effective in transcending language 

communication barriers and can target a broad range of audiences with varying 

levels of health literacy (Pratt & Searles, 2017). Many physicians frequently draw 

small diagrams of procedures to supplement their explanation of surgical 

procedures when consenting patients prior to their surgery (Kearns et al., 2020). 

In a study of 100 surgeons, 92% reported using and creating drawings routinely 

to consent patients, teach and communicate with other professionals, and 

document post-operative notes (Kearns, 2018). These results highlight how 

useful supplemental images can be when used during an explanation of a 

surgical procedure. Along with the rapid development of technology, multimedia 

tools and computer-based programs may help better inform patients as 

compared to traditional verbal-only explanations (Tait et al., 2009). These studies 

have illuminated the possibilities that visual aids can provide in medical and 

health education and in reinforcing the essential points patients need to learn to 

best understand their medical care.  

Adequate knowledge prior to a medical procedure can reduce patient 

anxiety and decisional conflict surrounding their care (Lopez-Olivo et al., 2019). 
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Visual and multimedia tools aimed at educating patients about their treatment 

plans can be viewed at their own pace, lending a higher feeling of autonomy and 

flexibility over their care (Ong, 2009). Tom (2021) found that many videos can be 

standardized to reduce the gaps in communication that may arise through 

physician verbal only explanations. Additionally, some studies that looked at the 

effects of educational videos on patient education found that knowledge retention 

and information recall improved with the addition of these videos. 

Currently, there are few visual tools illustrating the steps of percutaneous 

cholangioscopy or what patients should expect with this procedure. The results 

and development of novel educational multimedia materials from our study would 

inform best practices for developing patient education materials in interventional 

radiology. Multimedia produced in our study can also help raise awareness and 

improve understanding in referring physicians to better serve their patients.  

Cognitive Theory of Multimedia Learning  

 A prominent theory that underlies much multimedia research is the 

Cognitive Theory of Multimedia Learning (CTML) (Mayer, 2014). The theory 

asserts that people gain a deeper understanding of concepts when learning from 

both words and pictures rather than through words alone. The theory is framed 

by three assumptions: 

1. Dual channels assumption – Humans process visual and auditory 

information through two separate channels in their brain. 

2. Limited capacity assumption – there is a limited amount of visual and 

auditory information that humans can process at one time 
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3. Active processing assumption – humans actively stay engaged when 

learning through three consecutive processes 

a. Selection – deciding which information is relevant. 

b. Organization – arranging relevant information into 

comprehensible groups. 

c. Integration – connecting grouped relevant information to prior 

knowledge and experiences. 

Through these assumptions in the CTML theory, three specific goals are 

targeted when designing multimedia for learning: minimizing extraneous 

processing, managing essential processing, and fostering generative processing. 

The application of this theory and these principles will be delineated in the 

Materials & Methods section. These goals are broken into technical examples, or 

principles, a selection of which are outlined in Table 1 below: 
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Principle Description 

Coherence principle Remove excess and distracting 
material 

Signaling principle  Highlight important points 

Redundancy principle Use audio/narration and visuals 
instead of written text 

Spatial contiguity principle Text should be physically close to 
relevant visuals 

Temporal contiguity principle Audio and corresponding visuals 
should be presented together 

Personalization principle Keep narration in a conversational 
tone rather than a formal one  

Voice principle Use a human voice for narration 
over a machine voice 

Embodiment principle Use characters with human-like 
gestures 

 
Table 1. Table with selection of multimedia principles used in asset 
design.  
 
 

Intended Audience 

 The primary audience for materials created in this thesis project includes 

patients who are candidates for percutaneous cholangioscopy or who may have 

already had a cholecystostomy tube placed in preparation for this procedure, as 

well as referring physicians who may not be familiar with percutaneous 

cholangioscopy. Patients can refer to our created media when considering this 

procedure and physicians can become more aware of the procedure and better 

understand when to refer to patients with complicated medical histories. Findings 

from our study could uncover whether or not multimedia tools are beneficial to 

use when explaining an IR procedure. 
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 The media that we post online can also be used by the lay public, who 

may be candidates for this procedure or may know someone that could benefit 

from seeing an interventional radiologist. We plan for all materials created for this 

project to be accessible through the Johns Hopkins Medicine percutaneous 

cholangioscopy webpage. 

Project/learning objectives 

 This project aims to address the scarcity of approachable learning 

materials on percutaneous cholangioscopy through the following objectives: 

1. Create a high-yield multimedia toolkit for web (still images in a 

pamphlet and animated video) as a resource for patients to better 

understand percutaneous cholangioscopy when weighing treatment 

options.  

2. Increase awareness of percutaneous cholangioscopy and better 

educate physicians on referral criteria.  

3. Measure learning and engagement in patient and physician 

populations to determine the efficacy of our created media, and more 

broadly, the added value of multimedia tools in education of IR 

procedures.  

4. Test patient and referring physician preference for how a procedure is 

explained. 
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Materials/Methods 

Cognitive Theory of Multimedia Learning – Application 

 When designing and planning the visuals that would be included in our 

multimedia toolkit, we referred to the Cognitive Theory of Multimedia Learning 

(Mayer, 2012) and used many of its principles to create effective learning 

resources for percutaneous cholangioscopy.  

1. Coherence principle 

In order to focus the audience’s attention on the important information, we 

adopted the coherence principle by keeping minimal actions on each 

frame that would draw the eye to the line of action. Any extraneous 

sounds or graphics that were not directly related to the action on the frame 

were excluded to prevent interfering with the viewer’s comprehension.  

2. Signaling principle  

The signaling principle is used to highlight pertinent information using 

cues, highlighting graphics, or accenting text. We used visual cues to 

emphasize an instrument used or anatomic structure that were involved in 

the procedure. 

3. Redundancy principle 

People learn better with a combination of narration and graphics instead of 

narration, graphics, and onscreen text, so we kept onscreen text to 

minimum to reduce cognitive load when viewing the animation.  
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4. Spatial contiguity principle 

For the pamphlet design, we ensured that any labels and text within the 

images were as close as possible to the structures they were referring to. 

The smaller distance between image and label allows the viewer to exert 

less energy when trying to learn and makes it easier to quickly identify 

where to look for specific information. 

5. Temporal contiguity principle 

To minimize extraneous processing, the temporal contiguity principle was 

used in the animation to present narration and corresponding visuals 

together. The animation was timed to match the voiceover to make sure 

that the appropriate visuals and audio occurred at the same time to signal 

both the auditory and visual learning channels of the viewer.   

6. Personalization principle 

The personalization principle delineates that a friendly, conversational 

voice in the video narration helps foster generative processing and 

improves the learning experience (Mayer, 2014). The delivery of our video 

narration was simple and casual to allow viewers to feel more comfortable 

when viewing a potentially unfamiliar medical procedure. 

7. Voice principle 

People tend to learn best from a human voice rather than a computer 

voice. Dr. Harjit Singh, an interventional radiologist at Johns Hopkins 

Hospital, provided the full narration for the animation script in our video. 

As someone familiar with the percutaneous cholangioscopy procedure 
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and has experience explaining this procedure to patients, Dr. Singh’s 

voiceover could potentially simulate an actual in-person patient visit and 

the viewer may feel more comfortable learning the material as if he is 

speaking directly to them.  

8. Embodiment principle 

People learn better when on-screen character displays humanlike 

behavior. The representative characters in the animation were designed 

with humanlike proportions and secondary motions were added to 

simulate human movement tendencies. 

Script Writing 

 The script for the patients tested in our study was primarily written by Dr. 

Harjit Singh, an interventional radiologist in the Radiological and Radiological 

Science department of Johns Hopkins Medicine, based on what a typical patient 

to interventional radiologist interaction would be like in a clinical setting. Multiple 

iterations were edited to ensure that the language used to describe the 

procedure would cater to a wide range of health literacy. The referring physician 

script content was based off the patient script with minor vocabulary changes and 

content addition. To minimize any extraneous variables in our test, we decided to 

use the same script that would be used in the interventional radiologist’s verbal 

explanation of the procedure to patients to accompany the still images used to 

supplement the procedure explanation. We applied the same methods to the 

referring physician version of the procedure explanation script as well. 
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We chose to write a universal version of these two scripts to be used in 

the final animated video. We made sure the language used in this script version 

is approachable to patients that might have varying levels of health literacy. The 

same video could be understood by referring physicians that have higher health 

literacy and can be a resource they suggest to their patients. The animated video 

script was approximately 277 words that came out to around 2 minutes. Full 

versions of each script are included in Appendix A.   

Storyboarding 

 Storyboard sketches were created based on each script and partially 

directed each iteration of the script. Sketches were created in Procreate and 

imported into an Adobe Illustrator template to align each frame to the script. The 

storyboarding process went through multiple revisions and these sketches were 

then imported into Storyboarder to allow for more efficient editing and moving 

frames. Animation actions and transitions were added in Storyboarder (Figure 2). 

Content feedback primarily provided by Dr. Harjit Singh and the script finalized 

through storyboard creation.
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Figure 2. Example frame from storyboard laid out using Storyboarder. Full 
storyboard is available in Appendix B. Not all text intended to be read. 
 

Audio 

Script was recorded and edited using Adobe Audition. Noise was edited 

using the “Noise Reduction” feature in Audition. A noise print was captured using 

the lowest audio levels from the script recording (Effects > Noise 

Reduction/Restoration > Capture Noise Print) and used as a baseline to reduce 

any background noise (Effects > Noise Reduction/Restoration > Noise Reduction 

(process)). Audio levels were adjusted by evening out amplitude of any peaking 

bands (Effects > Amplitude and Compression > Single-band Compressor). 

“Match Loudness” settings were adjusted to ensure that the narration stayed 
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around the same decibel level throughout the entire recording. An “FFT Filter” 

effect with the “Kill the Mic Rumble” preset was used to reduce any pops and 

plosives in the audio (Effects > Filter and EQ > FFT Filter > Select Kill the Mic 

Rumble from drop down menu).  

Style/Asset Creation 

 Initial sketches were created to create characters that would represent the 

patient and physician populations in our animation story (Figure 3). A typical 

patient that presents with cholecystitis tends to be female, over forty, and 

Hispanic (Maurer et al., 1989; Portincasa, 2015). Therefore, our representative 

patient was depicted as a middle-aged female of color to take into account 

specific risk factors of gallstones and consider representing a diverse patent 

population. After initial sketches were drafted, we decided on an approachable, 

cartoon style with realistic proportions for the assets in order to accurately 

convey medical information without becoming too graphic for patient education.  

 

Figure 3. Initial character design sketches.  
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Figure 4. Refined patient sketch to be imported into Illustrator with added 
values and marking location of relevant internal anatomy.  
 
Final sketches with values were then imported into Adobe Illustrator to 

create scalable illustrations that can be used in animation and as still illustrations 

(Figure 4). Each element of the patient’s body was designed and separated into 

layers for the most efficient animation in After Effects (Figure 5). Bilateral objects 

like arms and legs were separated onto different layers to be able to keyframe 

them separately and produce more realistic motion. 
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Figure 5. Adobe Illustrator file with separated layers prepared for animation and 
rigging in Adobe After Effects. Text not intended to be read.  
 

For accurate radiological equipment ratios, Cinema 4D was used to build simple 

models to ensure accurate proportions.  

Animation 

Animation was done in Adobe After Effects. After Effects plug-ins used 

included Animation Composer, Duik Bassel, Omino Snake, and Motion3. 

Illustrator and Photoshop files were imported into the main After Effects file 

taking care to retain composition layers for full editing capabilities (File > Import > 

File > Choose File and select “Composition – Retain Layer Sizes” from dropdown 

menu). Most animated effects were achieved used key frames on position, 
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scaling, rotation, and masks. More complex animation that required external 

plugins are further outlined below.  

Rigging with DUIK Bassel 16 

The After Effects plugin Duik Bassel 16 was used for inverse kinematic 

character rigging. To add arm movement to the patient character, rubber hose 

arms were created using a combination of puppet pins and the auto IK rigging 

capabilities in Duik. 

 

Figure 6. Puppet pins placed for Duik Bassel rigging in Adobe After Effects. Text 
not intended to be read. 
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Figure 7. Puppet pins in After Effects layer hierarchy to create Duik Bassel arm 
controllers. 

 
Puppet pins were placed where the wrist, elbow, and shoulders are 

located on each arm (Figure 6). The pins were selected in the Layer hierarchy 

(Figure 7), renamed, and then used to create bones with Duik Bassel’s “Add 

bones” option. Once bones were created, the new bone layers were selected 

distally to proximally (wrist to shoulder) and an IK rig is created by selecting 

“Auto-Right/IK” to create a controller to move the arms. The amount of stretch 

and the number of triangles were adjusted to create realistic but still cartoon like 

movement when adding key frames. 

To produce a simplified head rig, Duik Bassel 16 was also used to create 

controllers that would be able to control multiple features at a time to reduce 

bulky animations with multiple repeated keyframes. The Duik controllers would 
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allow for streamlined animation and the animated head rigs can control multiple 

facial features to reflect Mayer’s embodiment principle. 

To simplify the head rig and reduce expressions to maintain efficiency by 

parenting all facial features that move together to the same null layer. Create a 

new null layer for all facial features (Layer > New > Null Layer). Parent all facial 

features to Facial Features Null Layer. The position of the target layer in After 

Effects must be separated to be able to be connected to a Duik controller.  

 

 

Figure 8. Separate dimensions into X and Y positions. 
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Separate X and Y dimensions on position in Facial Feature null (Figure 8) 

and zero out dimensions using Duik zero option. Set three x and y keyframes, 

each ten frames apart. Each key frame represents the maximum distance the 

animated objected will be able to move in the X and Y direction using the 

connected controller. Add a 2D slider controller making sure no layers are 

selected.  

 

Figure 9. Connect to controller using “Connect to properties” under Duik Bassel 
plugin. 
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Select either the X or Y under the position of the Facial Features null, then under 

“Children connection,” select “Connect to properties” (Figure 9). Repeat with the 

other axis and add controllers for other features as needed. 

Omino Snake   

Since the endoscope design was more complex than a simple stroke or 

path, an After Effects plugin called “Omino Snake” was used to create a smooth 

animation of the endoscope moving into the frame (https://omino.com/store/). 

The percutaneous cholangioscopy scope was designed using Adobe Illustrator 

as a straight object (Figure 10).  

 

Figure 10. Percutaneous cholangioscopy scope design and layers in Adobe 
Illustrator. Text not intended to be read. 

The endoscope file was the imported into Adobe After Effects as a 

Composition (Retain Layer Sizes). A precomp of the Illustrator layers was 

created in After Effects to streamline After Effect timeline workflow. Once in After 

Effects, creating a new solid layer provided the base for the desired scope path; 

https://omino.com/store/
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the path was drawn as a “Mask Path” on the solid layer and the “Omino Snake” 

plugin can be applied from the Effects panel (Figure 11). 

 



 
 

23 
 

Figure 11. Adding the Omino Snake plugin to the layer with the desired scope 
path (Effects > omino > omino snake).  

  

After adding Omino Snake to the layer with the mask path, the source 

layer of the “pert chol scope” pre-comp was chosen from the dropdown menu in 

the Effect menu (Figure 12, step 1). Next, the path from the path dropdown menu 

was chosen using the previously drawn mask path on the solid layer (Figure 12, 

step 2). The scale was adjusted to fit the scope proportionally within the 

animation frame. Finally, keyframes were added to the “Advance” option (Figure 

12, step 3), to animate the straight scope moving along the curved path into the 

frame 

 

 
Figure 12. Animating scope to bend along mask path using Omino Snake (Step 
1) 
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Figure 13. Animating scope to bend along mask path using Omino Snake (Step 
2) 
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Figure 14. Animating scope to bend along mask path using Omino Snake (Step 
3) 
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Study Design 

The study was approved by the Johns Hopkins Medicine Institutional 

Review Board on March 1, 2022 (IRB 00306054). We planned to test two groups: 

1. patients who are candidates for the percutaneous cholangioscopy procedure 

or who may have had a tube placed in preparation for this procedure, as well as 

2. referring physicians. Given the time constraints of our study, for this thesis we 

piloted the test on 1. Friends and family members to represent possible patients, 

and 2. IR residents to represent physicians.  

We measured and compared engagement and understanding of the 

procedure based on a scripted verbal or text explanation vs. the same verbal/text 

explanation with the addition of visual aids. We designed our survey using JHM 

Qualtrics since it is both secure and user-friendly. Participant understanding was 

measured using pre/post testing and engagement was measured through a 

preference survey that asked which modality they preferred learning from.  We 

created two versions of the survey, one for patients and one for referring 

physicians. The entire survey was estimated to take about 10 to 15 minutes to 

complete.  
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Qualtrics Study Flow  

Patient Group:  

In Block 1 of the study, patients that consented to participate were 

randomized into two modalities, a control and a treatment group, for learning the 

plan of treatment about the procedure: (1) Verbal explanation of the procedure by 

a physician (control), (2) Verbal explanation of the procedure by a physician with 

the addition of supplemental images (treatment). The verbal explanation pf the 

percutaneous cholangioscopy procedure was the same between the two 

experimental groups.  

In Block 2 of the study, all participants were shown excerpts of three 

presentation methods to choose their preference of information delivery (Figure 

15). Patients accessed the survey using a Qualtrics link on their smartphone or a 

paper printout if smartphone was unavailable. A QR code was provided to the 

patient to access the survey using their mobile device.  
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Figure 15. JHM Qualtrics survey flow, patient version. 
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Referring Physician Group: 

The referring physician group followed the same study design as the 

patient group, with two test blocks followed by surveys (Figure 16). Since the 

referring physician group would not be seen in person by an IR physician, we 

changed the verbal explanation in Block 1 to a text explanation that each 

participant could read through the Qualtrics survey link. Slight changes were 

made to the questions in each survey to reflect the differences in health literacy 

and medical background knowledge between both testing groups. Participants 

were randomized into a control group and a treatment group in Qualtrics (Figure 

17). Full versions of both surveys can be found in Appendix C.  
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Figure 16. JHM Qualtrics survey flow, referring physician version. 
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Figure 17. 1) Add a randomizer in Qualtrics to randomly distribute two options for 
testing, 2) Choose “Add a New Element Here” to add two test condition options. 
3) Select “Block” option to add previously created block with different test 
conditions. 4) Select block from dropdown menu. Not all text not intended to be 
read. 
 

Data Analysis 

We used f-tests and t-tests to look for differences in survey responses 

between study groups.  F-tests were conducted to test for homogeneity of 

variance, and we could proceed to t-testing if the variance of the initial data was 

the same (p>.95). We used t-testing determine if there was a significant 

difference between our control and treatment interventions (p<.05).  

Accessibility 

Our created media were adjusted to follow the AA standards of 

accessibility outlined in the Web Content Accessibility Guidelines (WCAG 2.1). 

The luminance ratio was measured to meet the required minimum contrast of 

4.5:1 for regular sized text and 3:1 for large scale text (at least 18pt, or bold and 
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at least 14pt). Contrast and color ratios were measured using the Colour 

Contrast analyzer software. 
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Figure 18. Color contrast analyzer software. Not all text intended to be read. 
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Results 

Multimedia Produced 

We created a patient education pamphlet and a video animation to test in 

our study.  
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Figure 19. Patient education pamphlet used for IRB study. Not all text intended 
to be read. Larger version included in Appendix D.  
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Figure 20. Selected animation frames from final animation.  
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Populations 

To pilot our test for the patient population, the survey was sent to friends 

and family (non-physician group) to include a range of health literacy levels. We 

received a total of 19 responses from participants with ages ranging from 18-64 

years old. To pilot our test for the referring physician representative population, 

we recruited current IR residents (IR resident group) in the Johns Hopkins 

Radiology residency program. We contacted a total of 20 residents and received 

responses from 12 residents (60%). 

Non-physician group 

Pre/Post Test Results   

Of the 19 total participants in the friends & family group, 8 received the 

text only explanation of percutaneous cholangioscopy and 11 received the text 

explanation with illustrations to describe the procedure. The average test scores 

between both non-physician groups increased after viewing procedural 

explanation, regardless of intervention type. The average test scores of the text 

explanation group (T) increased from 3.25/5 (pre-test) to 4/5 (post-test). The 

average test scores of the text explanation with images group (TI) increased from 

2.09/5 to 2.73/5 (post-test). There is no significant difference in pre-test scores 

between the T and TI groups (p = 0.85).  There is a significant difference 

between post-test scores between the T and TI groups (p = 0.008). Pre/post-test 

statistics for non-physicians are summarized in Table 2. 
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  Pre-test Post-test 
Change in 
score 

F-Test 0.55 0.78 0.52 

T-Test (two-tailed) 0.08 0.008 0.85 

Mean (T) 3.25 4 0.75 

Std Dev (T) 1.49 0.93 1.39 

Mean (TI) 2.09 2.73 0.64 

Std Dev (TI) 1.22 0.9 1.12 

  Table 2. Statistical calculations from non-physician group survey responses.  

 

 

Engagement survey 

 Participants were asked to rank survey questions on a 7-point Likert scale 

ranging from Strongly disagree (1) to Strongly agree (7).  The text group 

participants averaged scores ranging from 5.13 to 6.25 and the text & images 

group participants averaged scores ranging from 5.27 to 6.27. Engagement 

survey results are summarized in Figure 21. 
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Figure 21. Engagement survey Likert scale scatter plot from non-physician 
group. 

 

Engagement Survey Feedback 

 We received feedback from write-in questions asking each participant 

what they enjoyed about the explanation they received and what they felt was 

missing from the explanation. The overall themes that participants found useful in 

both explanations were “clear and concise explanations”, “easy to understand 

explanations”, and “images were helpful for visualizing”, as seen in Table 3.  
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Theme Total # of 
Responses  

Text Explanation 
Group (T) 

Text and Image 
Explanation Group 
(TI) 

Clear/concise 
explanation 

6 - It was very detailed 
and provided a good 
explanation of the 
risk and potential 
next steps after the 
procedure. 

- It was brief, 
accurate and 
informative  

- It was very detailed 
and provided a good 
explanation of the 
risk and potential 
next steps after the 
procedure. 

- It was brief, 
accurate and 
informative 
  

- The illustrations that 
accompanied the 
text explanation 
were very clear 

- The language used 
to describe the 
procedure contain 
just enough medical 
jargon to be 
relatable to patients. 

- Simple  
 

Easy to 
understand/follow 

4 - It provided an 
understanding of the 
procedure without 
feeling 
overwhelmed. 

- The easy-to-
understand wording 
 

- Easy to follow 
- The pictures are 

easy to understand.  
 

Images are 
helpful for 
visualizing 

7 - N/A - Helped me visually 
understand what 
would happen. 

- The easy-to-
understand graphics  

- The graphics were a 
great help. 

- The images helped 
me visualize the 
procedure. 

- Graphics and 
thorough explanation 
 

Table 3. Selection of comments related to common themes from survey 
feedback.  

  



 
 

43 
 

Some additional comments from some participants included appreciating 

the metaphors and delineation of risks used in the explanation. Furthermore, 

others found it useful that learning about the procedure could be self-paced when 

viewing the explanation with images.  

 We also asked for feedback on parts of the procedure explanation what 

participants felt were missing or could have been helpful for learning about 

percutaneous cholangioscopy. Some common themes in the comments included 

providing more information about the procedure, using simpler verbiage, and 

adding visuals to help explain the procedure. Additional comments included 

defining the anatomy involved and adding an overview sentence at the end to 

summarize the major points in the explanation.  
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Media Preference 

 After the engagement survey concluded the first part of the study, we 

polled each participant in the second part of the study for their multimedia 

preference. Out of the 19 participants, 11 ranked “Animation” as their first 

preferred method of explanation, 3 ranked “Pamphlet” as their first choice, and 3 

ranked “Text” as their first choice, as seen in Figure 22.  

  

Figure 22. Multimedia preference rankings from non-physician group. 
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IR residents 

Pre/Post Test Results 

Seven residents received the text only explanation of percutaneous 

cholangioscopy and 5 residents received the text explanation with illustrations to 

describe the procedure. There was no change in the average test scores 

between both groups after viewing procedural explanation, regardless of 

intervention type. The average test scores of the text explanation group (T) were 

at 4.86/5 from for both pre-test and post-test. The average test scores of the text 

explanation with images group (TI) was 4.4/5 for both pre-test and post-test. 

There was no significant difference in pre-test scores between the T and TI 

groups (p = 0.25).  There was no significant difference between post-test scores 

between the T and TI groups (p = 0.12). Pre/post-test statistics for the IR resident 

group are summarized in Table 4.  

  Pre-test Post-test Change in score 

F-Test 0.06 0.4 N/A 

T-Test (two-
tailed) 0.25 0.12 N/A 

Mean (T) 4.86 4.86 0 

Std Dev (T) 0.38 0.38 0 

Mean (TI) 4.4 4.4 0 

Std Dev (TI) 0.89 0.56 0 

Table 4. Statistical calculations from IR resident group survey responses. 
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Engagement Survey  

IR resident participants were asked to rank each survey question on a 7-

point Likert scale ranging from Strongly disagree (1) to Strongly agree (7). The T 

group participants averaged scores ranging from 6.14 to 6.43 and the TI group 

participants averaged scores ranging from 6.4 to 6.6, as summarized in Figure 

23.  

 

 
Figure 23. Engagement survey Likert scale scatter plot from IR resident group. 
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Engagement Survey Feedback 

 IR residents that received text or text and images in their percutaneous 

cholangioscopy explanation appreciated that “it was succinct” and “simple but not 

overly simplistic.” Additionally, multiple residents commented that including 

images was useful and included “appropriate details for a medical professional.” 

  When asked about what could be added to our explanation, one resident 

wrote that we “might want to include some detail on average number of 

procedures a patient may take to get all the stones out, the fact that it can take 

many months until the tube is removed, and the % success rate.”  

Media Preference 

We polled each participant in the second part of the study for their 

multimedia preference, with results illustrated in Figure 24. Out of the 12 

participants, 6 ranked “Animation” as their first preferred method of explanation, 6 

ranked “Pamphlet” as their first choice, and 0 ranked “Text” as their first choice. 

All 12 participants ranked “Text” as their third preferred choice. 
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 Figure 24. Multimedia preference rankings from IR resident group. 
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Access to Assets Resulting from this Thesis 

Access to the final multimedia assets resulting from this thesis project can 

be viewed at the author’s student page at 

https://medicalart.johnshopkins.edu/jenniferawang/. The author of this project can 

also be reached through the Johns Hopkins University School of Medicine 

Department of Art as Applied to Medicine at the above website 

(https://medicalart.johnshopkins.edu/). 

 

 

 

 

 

 

 

 

 

  

https://medicalart.johnshopkins.edu/jenniferawang/
https://medicalart.johnshopkins.edu/
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Discussion 

We created various multimedia assets to be tested in our experimental 

study, with the intention of making them available for future patients and referring 

physicians to learn about percutaneous cholangioscopy. With the results of our 

study, the design of our multimedia pieces could provide one framework for 

future patient education tools in interventional radiology. 

Initially when designing our IRB study, we planned to test patients in clinic 

who are or may be candidates for percutaneous cholangioscopy and referring 

physicians online who may not be familiar with the procedure. With the time 

limitations of the thesis project and late approval of our IRB, we were not able to 

begin collecting data from our initial target audiences. For this thesis, we pivoted 

to running a pilot study using the survey and multimedia assets we created to 

obtain some preliminary results and to check the usability and functionality of our 

surveys before testing on a larger scale.  

Performance on Pre/Post Test Surveys 

Our preliminary study showed that post-test scores were increased from 

pre-test scores in the non-physician group across both interventions. An increase 

in post-test score suggests knowledge gained of the procedure after 

experiencing an explanation. Our preliminary findings are consistent with other 

studies that have investigated the positive impact of educational interventions on 

knowledge of medical procedures (Lopez-Oliva, 2020; Laslett, 2011). Although 

our results indicate that the text only group (control) resulted in a significant 

difference of a higher score in the post-tests, the change between pre and post-
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test scores was not significant. Additionally, when looking at the pre-test scores 

across all non-physician participants, the control group had a higher baseline 

score than the treatment group that received both text and images in their 

explanation, which could account for the significant difference in post test scores 

where the text only group appeared to score higher overall.  

The difference in Pre and Post test scores between T and TI groups was 

likely due to low sample size. For our future test, it would be ideal to collect more 

participants to better represent the general population of procedure candidates 

with a more similar average baseline knowledge. Furthermore, all participants in 

the non-physician cohort had some level of tertiary education (college level or 

higher) and majority were in the age range of 25-34. Both factors could influence 

their level of health literacy before participating in our study and ultimately impact 

their pre-test scores. 

 In the IR resident group analyses, test scores before and after both 

interventions were nearly identical between both control and treatment groups. 

Since the test scores of IR residents already started at nearly the highest scores, 

there were little to no changes in their post-test scores and therefore no 

significant differences would be calculated.  

The IR resident group may not have been representative of the referring 

physicians we plan to survey. IR residents are likely to have more familiarity 

procedures such as percutaneous cholangioscopy than general physicians. We 

would want to sample from more representative population patients who might 

need this procedure or physicians who are not as familiar with interventional 
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radiology to test if our explanation of percutaneous cholangioscopy can be 

improved using supplemental media.  

Improvements to Our Study 

Overall, our pilot study ran as expected. However, we realized at least one 

test question that could be improved (Q4, shown below in Table 5).   

Q4: The gallstone removal procedure A. Is an outpatient procedure 

B. Requires a large incision 

C. Can be completed in one 

session 

D. Is successful ~20% of the time 

Table 5. Question from survey pre/post-test that needs clarification. 

The intended correct answer for this question is “A. Is an outpatient 

procedure.” When analyzing the results for both target groups, we found that the 

majority of participants selected the correct answer, regardless of non-physician 

or IR resident group. Of interest, there were a few individuals who changed their 

answer in their pre-test from the correct answer to the third answer choice, “C. 

Can be completed in one session.” Although, this was not intentionally a correct 

answer, a resident did note that the wording for this question could be confusing 

since percutaneous cholangioscopy is “often performed either inpatient or 

outpatient and can occur in 1 or more procedures (more often multiple).” 

Observing how specific wording could be confusing to both target groups, 

especially in their post-test scores, reinforced the benefits to our pilot study. The 

ambiguity in answer choice reflects the comments sent by the resident and 
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provides a helpful correction we can make to our survey to ensure that it is as 

clear as possible and our test results can be accurate in their analyses.  

Engagement Survey  

 Our engagement survey showed an overall positive reaction to our 

percutaneous cholangioscopy explanation and multimedia assets, with Likert 

scale scores averaging over 5 for each question (1 = most negative, 7 = most 

positive). Our results reveal promising trends where the treatment groups in both 

populations reported higher scores across all statements on the engagement 

survey than the control groups. The relationship we observed in our study 

between higher satisfaction with the addition of visuals parallels other studies 

that report that patients disclose better overall satisfaction and improvements in 

medical knowledge and recall (Crabtree et al., 2012; McPherson et al., 2001).  

 Both IR residents and non-physicians that were in the group that received 

text only explanation reported that they would have appreciated some sort of 

visual to aid in the procedural explanation. In addition, including more information 

in an explanation for physicians could be beneficial for them to be able to 

address any questions their patients may have even before seeing an 

interventional radiologist. 
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Media Preference 

Overall, participants in both the non-physician and IR resident group found 

the visuals included in the explanation useful. Many participants who did not 

receive visuals commented that they would have appreciated visuals to aid in the 

procedure explanation. Both the IR residents and non-physicians ranked visual 

media as their favorite modalities for learning about the procedures, with non-

physicians overwhelming preferred animation and IR residents having their 

preference was split between pamphlet and animation as their first choice. 

In the non-physician group, a small percentage of participants preferred 

learning from pamphlet or text over animation. One reason for the split rankings 

could be the range of health literacy amongst the participants. People with less 

familiarity with medical terms could find it easier to learn at their own pace using 

a pamphlet or reading text. In one study on patients with osteoporosis, 

researchers observed that patients with lower health literacy had an increased 

decisional conflict when deciding their plan of care after receiving an 

informational booklet (Lopez-Oliva, 2020). However, several other studies have 

been reviewed to show how video-based interventions can be more effective at 

improving patients’ knowledge than written material (Jeste, 2008). Our next step 

is to conduct our study with more participants to gain a better understanding how 

our media tools can help patients and improve patient education on 

percutaneous cholangioscopy. 
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Multimedia Creation and Limitations 

 The animation was created to address the need for accurate and 

accessible methods of patient education on percutaneous cholangioscopy. An 

unknown procedure can cause anxiety in patients and cloud their ability to make 

a truly informed decision about their care. Creating a video with patient friendly 

verbiage and visuals can help educate about the procedure while easing any 

anxieties without adding any unnecessary complex medical jargon. In addition, 

using a standardized animation to explain a medical procedure can prevent any 

discrepancies between physician explanations, and better equip patients with the 

knowledge of their treatments and what kinds of questions to ask. The pamphlet 

was created to provide an effective way to explain percutaneous cholangioscopy 

alongside still images based off the animation that can be used in self-paced 

learning.  

Our project encountered various challenges and limitations throughout the 

iterative process. Before designing and ideating our media tools, it could have 

been beneficial to run a needs assessment to determine the specific information 

patients specifically felt was lacking from their doctor’s visits. Timing was also a 

large factor in inhibiting the progression of our IRB study, and we did not run the 

full study as planned. However, our pilot study did suggest the importance of 

visuals in presenting new procedures to potential patients as well as physicians. 

We were able to correct and clarify parts of our survey and we are ready to 

collect data from a larger sample and look forward to running the main study. 
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Future Directions 

Moving forward with our main study, we will recruit in-person patients who 

were scheduled to receive an explanation of percutaneous cholangioscopy from 

an interventional radiologist, and we will also recruit referring physicians of 

various specialties via email. Dr. Singh will test patients in clinic, while we gather 

data from the referring physicians online. Ideally, we will be able to present these 

results at the upcoming Society of Interventional Radiologists annual convention 

to receive feedback and impressions to using multimedia as a teaching tool from 

a wider range of experts in the field of IR. 

If our results revealed that a certain medium is preferred over another, it 

would also be interesting to study how varying levels of information about a 

medical procedure affect patients’ satisfaction and understanding of their care. In 

our current study, we included less amount of medical detail to be approachable 

to a wider audience. It could be interesting to test if level of visual detail in a 

procedure affects patient’s understanding of their care and overall comfort. It 

would also be interesting to test if an interactive element could be added and 

how that could affect knowledge retention about percutaneous cholangioscopy. 
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Conclusion 

 Percutaneous cholangioscopy can be an effective procedure for patients 

with cholelithiasis who have exhausted all other treatment options. However, 

there is a dearth of educational resources that can be used to explain the 

procedure across multiple audiences.  

With this project, we have developed teaching tools that patients and 

physicians can use to better understand percutaneous cholangioscopy. In 

addition, we launched a pilot study on the efficacy of multimedia tools increasing 

knowledge and understanding about percutaneous cholangioscopy, with 

promising preliminary results from our pilot study. We were able to demonstrate 

effective learning through both our test script as well as our text with images. We 

also found that both non-physicians and physicians preferred to learn from 

resources with visuals.  

 The multimedia created in this study will be used to help patients and 

referring physicians understand percutaneous cholangioscopy and how it can 

benefit them. With encouraging results from our pilot study, we will continue with 

our initial study plan and use the same assets to test patients in clinic and 

referring physicians online. Our goal for this project is to be able to contribute a 

potential framework for developing multimedia tools for other IR procedure 

explanations with the intention of increased patient satisfaction and accurate 

physician referrals to IR, ultimately improving health outcomes. 
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Appendix A: Patient and Referring Physicians Scripts 

Patient Script 

Percutaneous cholangioscopy is an interventional radiology procedure 

that can help treat gallstones. Patients with right upper quadrant pain and are 

diagnosed with gallstones often have a tube placed in the gallbladder to help 

drain and relieve the blockage from the stones. This tube is exchanged for a 

larger tube in order to prepare the patient to come back in the near future for the 

percutaneous cholangioscopy procedure.   

For that procedure, we will take the previously placed tube out and 

through the tube pathway, a scope with a built-in small camera is passed into the 

gallbladder. Using a laser, the stones are broken up into smaller fragments. A 

basket is inserted, and the fragments are removed through the tube pathway. 

When the session for the day is completed, a new tube will be placed. Once the 

stones are completely removed, the drainage of the gallbladder is checked, much 

like pipes are flushed, to make sure there are no blockages from any remaining 

stones. If the drainage catheter is functioning, we will ask you to come back a 

couple more times for a staged removal of the catheter. Additional sessions may 

be needed to remove all the stones. 

Possible complications include infection, bleeding, dye reaction, damage 

to the gallbladder and the surrounding structures as well as a reaction to the 

sedation medication, which can include a change in your heart rate or blood 

pressure. Percutaneous cholangioscopy can be an effective treatment if you 

can’t undergo traditional gallbladder surgical removal and wouldn’t want a tube in 
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place long term. If you think you could be an appropriate candidate, you can ask 

your provider to refer you to an interventional radiologist. 

Referring Physician Script 

 Percutaneous cholangioscopy is an interventional radiology procedure 

that could benefit a subset of your patients with in dwelling cholecystostomy 

tubes. Patients with acute cholecystitis often have a percutaneous drain placed 

for decompression of the gallbladder. Once the acute episode has passed, they 

are assessed for a point of obstruction. These drainage tubes are typically 

exchanged on a regular interval to ensure patency.  Often these patients have 

co-morbidities that preclude operative management. These include heart and 

lung disease, a complicated medical history, and/or prior abdominal surgery.  

Percutaneous cholangioscopy can be an option for patients who are not 

surgical candidates. Gallstones in those patients are addressed in a minimally 

invasive fashion, through the access port created by the drainage catheter. For 

the scope procedure, under sedation, we will take the existing catheter over the 

wire and through the access tract, we will pass a small scope into the 

gallbladder. The stones are broken into pieces through laser lithotripsy and 

removed using a basket pulled out through the scope. A drainage catheter is 

then replaced. Additional sessions may be needed to completely clear the 

stones. Once the stones are completely removed, we will then make sure that 

the biliary drainage pathway is intact. If so, we then perform a staged removal of 

the catheter.  
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Possible complications include infection, bleeding, dye reaction, damage 

to the gallbladder and the surrounding structures as well as a reaction to the 

conscious sedation medication. Percutaneous cholangioscopy can be an 

effective treatment your patients who can’t undergo definitive surgical treatment 

and wouldn’t want a long-term tube in place. If you think your patient would be an 

appropriate candidate, you can refer your patients to an interventional radiologist. 
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Appendix B: Animation Storyboard 

 

Figure 25. Animation storyboard, page 1. 
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Figure 26. Animation storyboard, page 2. 
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Figure 27. Animation storyboard, page 3. 
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Figure 28. Animation storyboard, page 4. 
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Figure 29. Animation storyboard, page 5. 
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Figure 30. Animation storyboard, page 6. 
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Figure 31. Animation storyboard, page 7. 
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Figure 32. Animation storyboard, page 8. 
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Figure 33. Animation storyboard, page 9. 
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Appendix C: Referring Physician Qualtrics Module 

 

Figure 34. Qualtrics module, page 1. 
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Figure 35. Qualtrics module, page 2. 
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Figure 36. Qualtrics module, page 3. 
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Figure 37. Qualtrics module, page 4. 
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Figure 38. Qualtrics module, page 5. 
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Figure 39. Qualtrics module, page 6. 
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Figure 40. Qualtrics module, page 7. 
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Figure 41. Qualtrics module, page 8. 
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Figure 42. Qualtrics module, page 9. 
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Figure 43. Qualtrics module, page 10. 
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Figure 44. Qualtrics module, page 11. 
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Figure 45. Qualtrics module, page 12. 
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Figure 46. Qualtrics module, page 13. 
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Figure 47. Qualtrics module, page 14. 
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Figure 48. Qualtrics module, page 15. 
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Figure 49. Qualtrics module, page 16. 
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Appendix D  

 

Figure 50. Patient education pamphlet, outside panels. 
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Figure 51. Patient education pamphlet, inside panels.  
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